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Configuration Tips

= Enable Online Directory
= Lists including Clean Up
= Reminders:
- Cleanup list
- Untick allow free text reminders
- Tick to allow free text comments
= Care Plans — Setup Care Plan Templates (EPC)
= OR Use Autofill shortcuts in Care plans
= Messages — Set up Groups
= Appointments: - Include Inactive patients in appointment searches
= Appointment Reminders: Exclude appointments with one reminder sent
= [nvoice Notes — add your common direct billing explanatory notes

= Enable National Cancer Screening Register (NCSR) access

Train IT Medical trainitmedical.com.au



Set your preferences

F User preferences

Letters

-
o

—
Prescribing

Clinical

Pathalogy

3

Imaging

User name: Dr Frederick Findacure
Today's notes font: Arial
Usual visit type:
Defautt temperature site:
Inttial focus in Observations window: (®) Pulse
] Mllow blank nates
Prompt f no notes recorded

] Enforze entry of Reason for Visit when closing patient record
Prompt for Reason for Visit when closing patient record

[] Don't start timer on opening record.

[] Dont recond wvisit length.

Reason for visit at top of notes

[ Use SOAP headings for History and Examination

] Load SOAP headings on opening notes

Display a My Health Record prompt in the Reminders box

Send reminder for influenza vaccination

Diagnosis window:
Always "Add to Past history”
Always "Save as Reason for Visit”

Reason for Visit window:

[ Mlways 'Add to Past history’

~ Clone
~| |10 v
A

() Sitting BP

[ Show "Mon visits'in Past Visit list

Display Outstanding requests in patient record

[] Use bald fort for Allergies and On screen comment

Load PMH favourites on opening New PMH window

[ Expand Cumrent Rx and PMH in tree view

Separate PMH into Active and Inactive in tree view

[ Expand Inactive PMH in tree view

Open the PMH window with the cursorin the date field

[ Popup Preventive Health list when opening patient record
Mark new PMH to be included in Shared Health Summaries

Procedure window:

Always "Add to Past histary'
] Aways "Save as Reason for Visit’

Past History window:

[ Aways “Save as Reason for Vist"

Save Save & Close Close
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Tips for Preferences

= General -
— open patient in Today’s notes E
- Enable HealthShare Factsheets Senere!
= Prescribing Leﬁj

- Routinely prescribe repeats for once only medications

= Clinical =
- Untick ‘Always Add to PMH’ \%V

= Pathology B
- Set up ‘Favourite tests’ Pﬁ?
- Clone to other users |
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Word Processor

v' Template Favourites

v Importing Templates

v’ Editing Templates & inserting fields
v Care Planning

v Autofill

v’ Label clearly

v Customise system templates

v' Sending documents using Email
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Template Favourites

F4
Add > Select Template

Template favourtes:

Template name

Asthma referral template

Australian Hearing refemral

Care Plan

Case Conference
EPC Refemal
Specialist refemral

Add

Delete

Train IT Medical
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Templates

v'Design an efficient labelling ‘system’
eg.

.. File. Open Request Clinical View Utilities |
Referral — Sydney Breast Clinic s

i Open patient in new window Alt+F2

Referral — Sydney Eye Hospital Jume to patient —
Referral — Sydney Day S_urgery Close patient -
Referral — Sydney Hospital Export patient o=
New letter F4

v'Restrict access

v'Back up to hard drive
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Turn paper forms into templates

Any form can become a template with ‘custom’ fields.

Double click on an item in the list to £ Custom field X
insert it into the document. : !
Field name: Reports preferred by: \
+ - General Field type: Delii o Field length: 10
3 Current user Short text
+- Doctor Long text Add Edt Delete
+ Addressee Numeric
o . List Fax Only
3 Referring Dr o iy Fax
Fu a'ﬂ' m'ta:t Dat Fax and Email
: R - Email Only - we prefer a paperess syst
+- Patient Logical
+- Clinical Checkbox
+- Reminder letters Defaut value: (BB e orderapd v
-| Custom
. Custom field Formatted date [C] Allow muttiple selection
Counter field [C] Save value [] Use last saved value
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Sending documents via Emaill Ii"i

F Bp E-mail )4
From WO rdprocessor Ta: |doctors @alfredcardilogy com au; donaldd @test.org.au | [
eUse a template to create a document Use adhessee emall [ Use patient erma
eSelect Email symbol @ cc | | B
eEnter an email address or select a recipient Subject: |REFERRAL LETTER - Donald Duck |
eSend Atachmert: ()REF @PDF [APIN:

Use account: | {medical@amsredfem org.au) smip office 365 ~ Send Cancel

Send using electronic fax service to a fax number e.g. (fax number@fax.net.au)
Default PIN = DDMM (patient DOB)

Can enter multiple email addresses, separate by a semi colon (;)

Add email addresses to frequently used contacts and patient records

Note: Send via PDF and untick PIN if you don’t want to restrict access to the attachment
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Creating specialist list for patients

Cardiologists ,l? Select other contact x

From Address Book  HealthShare

Mame Search: | Category: | Cardiology w
Dr James Brown (A) cal Directore
From WO rd processor 3 Smlth St Lg) D:'JDamestB:u‘vn{ﬁ} { Cardiology ) [ Argus ]
Penrith 2750 g Kimmiren i
Phone: 0298997688 ¢ 5555

. &, Dr Sally Robins (Cardiology )
o pen B lank Document Fax: 02 98767655 o B4 S 20
-l 30 Smith Street, Sydney, 2000.
eSelect Other Contact > Full
Dr John Jacobs (H)
details 5 Pond Rd

. Mew contact Edit contact Synchronise ) Synchronised with Online Directory \k Secure eReferalz available
Sylvania 2760

° Online Directory:  City/Suburb: ostcode: ax Distance: act postcode matc
® F I I t e r by C a te g O ry P h one. 5987 998 8 1Yy You have s.:mj: csat:gfr,.- with no mappings to the specialtie:;n the aninlgrmlr}-. - : : :
eSelect each specialist

Fax 598? 6767 Please map this category in Configuration, or by loading a contact of this specialty, to see results in the Online Directory.
eSave and prlnt Dr Penelope Smithson (H)

30 Smith Street
Sydney 2000
Phone: 0459898776

Fax: 98987766 ==

Train IT Medical
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Adding an eSignature to a document

The first step is to create an electronic
signature file (.PNG) and save to a secure
location such as your desktop.

1.

2.

Go to Bp Wordprocessor

Create a new document (Template > Use
template)

Move the cursor to the position in the
document where the signature should be
inserted

Select Insert > Picture > As Character

Select your signature file (from Desktop)

Train IT Medical

Smolkes 3 cigarettes/day. Started 2000.

Y ours faithfully,

Dr Frederick Findacure
MBES
2411401F

Insert  Format  Table Templates  Utilities  Help
AutoFill
| | ko]
File
Hyperlink
Object >
Page break
Page numbers
Picture » Az character
Symbol Fixed
Open s
Lookin:| Signature v| S F = m-
Quick access 4;
bislei Dr Smith signature
m
Libraries
This PC
Nei-.;a;vork
File name: || w~ | QOpen
Files of type: Image files w Cancel
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Letterwriting: Use Shortcuts & Secure Messaging

eg. We prefer to communicate electronically.
We use [insert secure messaging provider & details]




Online and Local Directories 7

el

J?.; Select addressee X
From Address Book Search on MEDrefer HealthShare
Name Search: | Category: | Cardiologist Y
L

Local Directory:
a P Smith (Cardiologist )

New contact Edit contact Sinchronise ) Synchronised with Online Directory ')% Secure eReferals available
Online Directory: Postcode: Maximum Distance: Exact postcode match

You have selected a category with no nappings to the specialties in the Online Directory
st emeaemea-amamreihin | or by loading a contact of this specialty, to see results in the Online Directory
Cancel
< 7 Indicates the contact is able to receive eReferrals
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w;

Sending Documents Bp Premier
 BestPactice Word Processor - United TR

File Edit View Insert Format Table Templates Utilities Help

= AR IR Il 00 2=k & 3~
L : 12...1
Double click on an item in the list to
insert it into the document.

B

[+ -+ -+

+
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Autofill Shortcuts for care plans

To add an autofill shortcut in Bp Premier: £ Autofill entry x
. Times Mew Boman “r b i u o §
*Copy (Ctrl+C) a single row from the table below o gy S ——y ———
*Open Wordprocessor (F4) Detect. morior and mansge comorbiditesinconjuncrion
.Select Insert > AutOflll support groups and sdu-:atim:al TEZOULCes
Spirometry dome: Lung Foundation Australia Lesel
.Add l:_ 11 Fi.‘l’lﬂ]:]lﬁj,—' Strest hiilton, Ii_}]_D 4064 Aunstralia T: 1800
*Paste (Ctrl+V) the row into the ‘Text’ field P30 W hingloundation com 2
*Name the shortcut (always use a syn,lbol S Goro
before the shortcut name e.g. .COPD’) T
. . «|itwvailable to all users:
*Tick to make available to all users
.Save Data element Save Cancel

Train IT Medical trainitmedical.com.au



Autofill Shortcut samples for use In care plans

Patient problems /
needs / relevant

Goals - changes to be achieved

Required treatments and
services including patient

Arrangements for
treatments/services

conditions actions (when, who, contact
details)

ATRIAL 1. Determine cause and treat FPharmacological treatment |ECG done
FIBRILLATION appropriately Encourage healthy weight Echo: Cardiologist:

2. Restore heart to normal rhythm |Encourage smoking

and reduce heart rate cessation if required

3. Blood clot prevention Encourage avoidance of

4, Manage risk factors for Stroke alcohol and other drugs

5. Prevent additional heart rhythm |ECG annually and PRN

problems Cardiologist review annually

6. Prevent heart failure and PRN
Alcohol Use Reduce risk of alcohol related harm | Cutpatient or residential Alcohol and Drug
Disorder/ over a lifetime by having no more |detoxification and Foundation (list of services)
Dependence than 2 standard drinks per day rehabilitation https:fadf.org.au/help-

Reduce the risk of injury while
drinking by drinking no more than
4 standard drinks on one occasion

Aim to have alcohol free days or
Abstinence from alcohol use

Counselling: individual or
Group support such as
Alcoholics Anonymous |
SMART Recovery or other
groups Referral to Addiction
specialist

support/support-services-
directory/

Train IT Medical
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Using Healthlink SmartForms HL

AWk
NSW

GO FEMMENT

| ]
Transport i'.l.
for NSW NSW Fitness to Drive Medical Assessment Park | Helpw

Medical Assessment Ak
Information Required

+» Driver Licence Verification

@ Driver licence number O Customer number
Attachments / Reports Driver licence number® S8453AL Patient surname
Patient consent obtained* Validate / Retrieve Date of birth
Current medical assessment information Address
Patient Information Name
Date of birth

Licence number .
Recipient / Referrer A Licence class Reason for medical
Field of practice” General Practitioner -

Medical standard®

Assessing medical |Please Select v P
standard”

https://au.healthlink.net/products/smart-forms/
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Sending pathology request forms to a patient

From: DoMNotReply@-clinicallabs.com.au <DoNotReply@clinicallabs.com.au=
Sent: Thursday, 9 June 2022 2:30 PM

To: Sue Cummins <scummins@amsredfern.org.au>

Subject: Telehealth pathology referral form for Donald Duck

Dear Donald Duck, 1.Generate pathology request
This 15 an email to notify you that vour doctor, Dr. Sue Cummins has requested vou visit a Collection Centre for pathology testing. 2 . E nte r ‘te | e h e a It h ) i n Cl i n i Ca | d eta i | S
Please find attached to this email your electronic referral form created by vour doctor. . .
| | - | 3.Make sure the patients email
Please bring an A4 print-out of this form with you to the collection centre.
To find your nearest Clinical Labs collection centre, please feel free to view our location finder using this link_ a d d re S S I S re CO rd e d O n t h e I r B p

If vou have anv questions or concerns please call our patient call centre on 1300 453 688 and one of our operators will be happy to help. f' I

Kind regards 4.Select ‘Print and Send”

Australian Clinical Labs

T: 1300 453 688

Practice must be set up to use ePathology
Each lab may have a slightly different process so check details before sending
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Today’s Notes

v Use Autofill button to create shortcuts to save typing time.

Excision lesion - performed under sterile conditions
Local anaesthetic: “% xylocaine with adrenaline
Instruments Sterilisation No: » Use Shift + F5 to move

Lesion Size: " between carats.
Suture Material: »

Number of sutures: *
Removal of Sutures in * days
Education re care of wound given

Specimen sent to *

Download samples

Train IT Medical trainitmedical.com.au
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Past History List [coding]

& Past history
fj Past Medical History X :

owe: [ /[ ] Orosm

Search:  [SHOULDER R || Keyword search S 3] D Inactive
Condition I }

Condition "

Shoulder reconstruction O Leﬂ []Right [ Bilateral “ O n I y f O r

Acute Chronic

chronic conditions

Oécivel [ inactive
[ Provisional diagnosis & Slgn Iflca nt eve nts
Fracture:
& Undisplaced
mp nutec
b iral nstick
Further details:
Dr Ken Low - Port Macquarie Hospital Send to My Health Record V . . pn .
e Significant active

Include in summaries

Save as reason for visit O r i n aCtive
[] save this condition in favourites list e - - CO n d i ti O n S

Criterion C7.1 — Content of patient health record, RACGP Standards for general practices 5th edition.
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Time for quality, time for coding

Demographics - are the contact details up-to-date?

+ [Double-click on the patient’s telephone number to check
and update details

Medication List - is the Current Meds list accurate?

= Right click to deletef/cease medications no longer relevant
[they can then be found in the Old/Past Scripts thereafter]

+ |f none, tick No medications

Past History List - does it contain only significant
conditions that a hospital or specialist would need
to know?

= Right click to edit, delete or add new
* |f none, tick No significant past history [PMH] box

Allergies - have you also recorded adverse reactions?
* Double-click in allergies box and Add, Edit, Delete

« |l none, lick No Known Allergies/Adverse Reactions/MNil Known

Immunisations - have immunisations been recorded?

Tip: Recall regular patients and make
appointment for a health check to
update and upload their health
summary.

Train IT Medical
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Correspondence Management

v Scan from the Bulk Document Import Tool

Bulk Document Import
Desktop app

v Design a ‘document management’ and labelling ‘system’
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The Inbox

l Pathology Results

' Radiology Results

L

l Discharge Summaries

I Scanned documents

Train IT Medical trainitmedical.com.au



Setup Pathology Favourites

B User preferences
G User name: | Dr Frederick Findacure i Clone
El Custom tests: Custom reasons:
General
Tests Comments
1. Setup > Preferences : -
> P h I Letters £ Favourite tests
at O Ogy L Favourte names Tests included
=1 123
2 Add Prescribing Add Delete Antenatal screening ADF
. ==t Include default tests in list Cervical Screening Test Amylase
.»IaJZ.. Diabetes Anti-cardiclipin Antibodies
Favourte tests: Diebetes review B12
- . E/LFTs BSL
Clinical G w
3. Create Group tests ics eneric o Corbamazepine
Favourite details & FBE FEC
‘ 12 month follow up HbA1C
i HOL Cholesteral
4. I N h r r Pathol Antenatal screening _
C O e to Ot e use S —l Cervical Screening Test Histology
i Diabetes PSA
as req ul red - Diebetes review Routine v i Sl
. BLFFS z'rn L WP N }
Imaging ESR .
rnc Rename
Add Edit Delete Close
]
Defautt biling: () Private (O Concession (@ Direct Bil () No default
Save Save & Close Cloze

trainitmedical.com.au



Clinically Significant Tickbox

# atio > |
Z ~ — F Reminder reason *
e eminder reason H
‘,/ Blood Test (Clinically Sigrificant Label SO patlents
. Bowel screening Reason: ervical Screening Test

General

e heck don't stress if they

& - Call patient Type: Momal ot .

. %?h " E:: ;:llaa: Review Clinically significant rece Ive. a S m S Or
Convn Sy Tot i "7 [I|  Obers letter with the

Add Edt || Delete | O Weeks reason.

() Months
(®) Years
Reminder type
e Save Cancel
MNomal
Lists Chronic Condiion Clinic Custom Reason 40 ]
Date Due 20
o nl Doctor 45
i 2 v
Remind
— Add Edit Delete Add Edit Delete
E.:-._: [ Allow free text reminders
— . 4
— Allow free text comments Send as: Mail merge >
Care plans Check "Mark as sent’ box as default
‘J Default reminder list interval: 1 week e
Display Actions/Reminders less than months old
E-mail

@ Save Cancel
v

trainitmedical.com.au




Receiving Documents

View Inbox (F3)

& Inbox

File Edit Utilities View Help

JHIER WM & B

- a Ahem. Jason
- Y 09/03/2011 SE-_ROUTINE CHEMISTRY
= a Allen, David
@ 27/10/2008 SE-_PSA

@ 27/10/2008 _THYROID FUNCT. TEST
. @ 20/11/2009 SE-_ROUTINE CHEMISTRY
- a Allen. Fay
@ 20/10/2003 MODIFIED RAST
= a Allen. Janelle
@ 02/12/2009 Cl-COAG

© 15/10/2009 CI-COAG

€ & 3 Lk B

RHERN, JASON

SONIC PATHOLOGY, BURNIE. 7320

Birthdate: 31/05/1977 Sex: M Medicare Number:
Your Reference: Lab Reference: 14551995-C-Cl140
Laboratory: SONIC PATHOLOGY
Addressee: DR FREDERICK FINDACURE Referred by: SONIC PATHOLOGY
Name of Test: SE-_ROUTINE CHEMISTRY

Requested: 09/03/2011 Collected: 08/03/2011 Reported: 26/08/2011 16:24

Clinical Notes: 24HRS REIGERATED

Train IT Medical
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Check Unallocated Correspondence

View and allocate regularly to minimize risk

& Incoming reports
File Edit View Help
‘TR
Find patient |:| [[] Show unallocated only
Date Patient name on report Test Addressed to Allocated to patient Allocated to user
17/01/2012  ANASTASIA ABBOTT SE-SEROLOGY DR IVOR CURE Anastasia Abbott Dr Ivor Cure
17/01/2012  ANASTASIA ABBOTT SE-HIV SEROLOGY ARC DR IVOR CURE Anastasia Abbott Dr Ivor Cure
17/01/2012  ANASTASIA ABBOTT GENERAL M,C&S 1 DR IVOR CURE Anastasia Abbott Dr Ivor Cure
17/01/2012  ANASTASIA ABBOTT U-URINE M.C&S DR IVOR CURE Anastasia Abbott Dr Ivor Cure
17/01/2012  ANASTASIA ABBOTT GENERAL M.C8S 1 DR IVOR CURE Anastasia Abbott Dr Ivor Cure
17/01/2012  ANASTASIA ABBOTT U-URINE M.C&S DR IVOR CURE Anastasia Abbott Dr Ivor Cure
17/01/2012  ANASTASIA ABBOTT U-URINE M.C&52 DR IVOR CURE Anastasia Abbott Dr Ivor Cure
17/01/2012  ANASTASIA ABBOTT SALMONELLA ID DR IVOR CURE Anastasia Abbott Dr Ivor Cure
17/01/2012  ANASTASIA ABBOTT HE-TROPONIN T DR IVOR CURE Anastasia Abbott Dr Ivor Cure
1770172012 MAREE ACKERMANN SE-_ROUTINE CHEMISTRY DR IVOR CURE Maree Ackermann Dr Ivor Cure
17/01/2012  MAREE ACKERMANN Cl-COAG DR IVOR CURE Maree Ackemann Dr Ivor Cure
17/01/2012  MAREE ACKERMANN ED-FBE DR IVOR CURE Maree Ackermann Dr Ivor Cure
17/01/2012  MAREE ACKERMANN _ROUTINE CHEMISTRY DR IVOR CURE Maree Ackemmann Dr Ivor Cure
17/01/2012 MAREE ACKERMANN SE-_ROUTINE CHEMISTRY DR IVOR CURE Maree Ackermann Dr Ivor Cure
26/08/2011  JASON AHERN SE-_ROUTINE CHEMISTRY DR FREDERICK FINDACURE Jason Ahem Dr Frederick Findacure
26/08/2011  DAVID ALLEN SE-_ROUTINE CHEMISTRY DR FREDERICK FINDACURE David Allen Dr Frederick Findacure
26/08/2011  DAVID ALLEN SE-_PSA DR FREDERICK FINDACURE David Allen Dr Frederick Findacure
26/08/2011  DAVID ALLEN _THYROID FUNCT. TEST DR FREDERICK FINDACURE David Allen Dr Frederick Findacure
09/11/2003  FAY ALLEN MODIFIED RAST DR FINDACURE Fay Allen Dr Frederick Findacure
26/08/2011  JANELLE ALLEN Cl-COAG DR FREDERICK FINDACURE Janelle Allen Dr Frederick Findacure
26/08/2011  JANELLE ALLEN Cl-COAG DR FREDERICK FINDACURE Janelle Allen Dr Frederick Findacure
<
Allocated to user:  Dr Ivor Cure Allocate to User Auto-allocate
Patient details: Miss Anastasia Abbott Allocate to Patient
Date of bith: 25/02/2004
12 John St, Albany Creek, 4035,

trainitmedical.com.au
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V. At m . d R | t F Mr David Anderson - Atomised result values — O *
lew omise eSulitsS R
16/06/2001 16/06/2002 16/06/2003 16/06/2004 16/06/2005 16/06/2006
CHOL 43 7. 6 51 39 4
CREATININE 60 7! 64 70 74 67
HbATc (S1)
HOL 13 16 292 1.7 15 115
LOL 25 5.7 214 27 159 168
TRIG 12 14 05 15 1 12
« From GRAPH button via Inbox
* From ATOMISED VALUES on patient
record (Investigations tab)
€ >
Currently logged in: Dr Frederick Findacure (Main surgery) Tuesday 05/07/2022 02:17:36 PM
This result is: Action to be taken: Store result in: Store for location: | Main surgery -
() Normal (©) No action () Investigations Include header
() Abnomal (O) Reception to advise (®) Comespondence in Details
() Stable () Nurse to advise (O Clinical Images
() Acceptable (O) Doctor to advise Send Message
() Unacceptabls () Send routine reminder Add Reminder || Add Past History Add INR
() Being treated (C) Non-ungent appointment Add Action Add CST result

(O) Under specialist care () Ungent appointment ¢ Previous Next » Skip Finish
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10 tips for Pathology & Radiology

View and re-use previous requests

View previous results

Clean up Outstanding requests

Design a practice ‘system’

Add custom notations eg. under Specialist care
Use filters in Follow Up Inbox

Add an entry to the actions database

Enter cervical screening from Inbox

Enter FOBT and mammography

10. Change test details from Inbox

Train IT Medical trainitmedical.com.au
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PATHOLOGY REQUESTED BY CLINICIAN

v

INCOMING REPORTS —= INBOX

L 4

NC
ACTION

DOCTOR
TO ADVISE

URGENT
APPOINTMENT

Result is filed in patient
record.

I

Doctor contacts patient.

Doctor advises of result
at next patient visit and
marks result as given in
BP.

|

Records contact details
in patient notes.

Marks result as given.

| )
TranIT

NON-URGENT
APPOINTMENT

w

RN checks list daily and
telepheone patients.
Appointments to be made
within one week. RN
records ‘note’ in BP and
marks appointment as
‘recall’.

RM checks list daily and
telephone patients.
Appointments to be made
within cne menth.

w

w

Doctor marks result as
given in consultation
when patient returns.

Doctor marks result as
given in consultation
when patient returns.

Down

load samples

Train IT Medical
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Enter CST result from the Inbox

Add CST result

Add a result from the
Inbox or from the
Cervical Screening
area of the patient
record

Train IT Medical

£ Cenvical screening result

Date performed:

Performed by:

HPV PCR:

LBC Result:

Other information:

271172018 @~ | Lookup Ix
Dr F. Findacure + | []Include inactive providers
(® Cervical Screening Test (O Pap smear
[[] Unsatisfactory specimen
HPV 16 (O Detected (®) Not detected
HPV 18 (O Detected (®) Not detected
HPVnot 16/18 (O Detected (® Not detected
Negative T'}’
Unsatisfactory

Possible low-grade squamous intra-epithelial lesion
Low-grade squamous intraepithelial lesion

Possible high-grade squamous intraepithelial lesion
High-grade squamous intraepithelial lesion

Atypical endocervical cells of undetermined significance
Atypical glandular cells of undetemmined significance
Possible high-grade glandular lesion

Endocervical adenocarcinoma in situ

Adenocarcinoma of the cervix

trainitmedical.com.au



Mark results as ‘given’

Mark result as given

Filter: v Mark result as given Atomised values
Date Test name Checked by Date checked Action Status Comment Provider
[] 01/09/2008 ED-GLYCOSYLATED HB A1C Dr Frederick Findacure 27/10/2011 Doctorto advise /o Abnormal PATHOLOGY |
[ 1411172018 breast Mammogram screening Dr Ivor Cure 14/11/2018 Nomal Best Pathology
Add
Delete
Open

Mark as given
Move to Correspondence in

V'Kw notes

S

View contact notes from test results using right click

Train IT Medical
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Use filters in Follow Up Inbox to find outstanding items

Al
H All unactioned
Dr Ivor Cure Reception to advise

. N to advi
O Fredenck Fdsce Lo e

Send routine reminder
Non-urgent appointment
Urgent appointment

No action

All

Train IT Medical trainitmedical.com.au



National Cancer Screening Register (NCSR Hub) .

View test results and screening histories

View screening status and alerts

Submit information and forms to the Register
View and update patient details

Manage screening participation

Cease correspondence for the cervical screening
program

Nominate others to assist your patient (e.g
personal representative or another Healthcare

Provider).

Bp Premier Quick Reference Guide

Nerdcaons

" LEFEN
Beast F L —_— Ll o
Patient Mame: sabelle Spears
. EEaaT F d FC
Patient Medicare No: 3572255850
Proscran Al Status Last Screening Date = | Screening Actio
Bowel ﬁ Actively Screening 1/08/2019 ﬁtlpppr{ Round (eligible on 27 Jul 2023) &
Cervical Mew to Screening NOW DUE -
Patient MCSR History
Show: | Bowel | Cenical ]
rograr [rate = | Description Chutcarm
¥ Cervical 31082020  Cervical Screening Histony Open Delete &
Bowe 31/08/2020 NBCSP - GP Assessment Report Referred for Colonoscopy Open Delete
B 168/08/2020 MNBCSP - Colonoscopy Repart Cancer/Suspected Cancer Open Delete

Open patient record (F2)
View > NCSR hub

trainitmedical.com.au
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Access AIR (from patient record) Ve AR | Creck AR Aoces

Date Status Waccine Dizeazes
£ View s oHzanne Lotise Lummins X 18/06/2021  Given COVID-19 VACCINE AST
171272024 Given Pfizer Comimaty COVID-159
s Get Individual Immunisation History Statemert —— 12/04/2022  Given Vaxigrip Tetra Influenza
- 5 r—
¥ Immunisation History:
General
Date Waccine Brand Dose Status  Editable  Action Req Reason Code  Mess
171242021  Pfizer Comimaty v Walid M M -
18/06/2021 AstraZeneca Vaxze... V Valid N M § " =
i 23/03/2021 AstraZeneca Vaxze.. V P, Australian Government iy o TYo [To¥= =)
- Save to patient record Services Australia

Immunisation history statement
@ As at: 05 July 2022

) For: SUZANNE L CUMMINS
Medical D f birth: 05 October 1965
Contraindications ate.of birth: BRI
Individual Healthcare Identifier (IHI): 8003 6011 8269 2694
_:—"’-Hx"-\_
Vv CFER T ———
. 23 Mar 2021 COVID-19 AstraZeneca
Matural Immunity
Vaxzevria
_'- 18 Jun 2021 COVID-19 AstraZeneca
ﬁll Vaxzevria
e 17 Dec 2021 COVID-19 Pfizer Comimaty

Vaccine Trals

No vaccines due.
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Tips & timesaving shortcuts - General

Use Head of Family to link family members

Jump to open another family members record during a consultation.
Finalise visit to add to appointment book.

View previous patients list (Shift + F2)

L e

Move quickly through lists by clicking on the first name in the list then
type the first few letters of the name you are searching for.

Use ‘Link to Patient’ in Messages for audit trail.
Keep patient data up-to-date and clinically relevant.
Export daily appointment list to USB for paperless backup.

v 00 N O

Keep a charged laptop handy.
10. Perform regular backups and test them.
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More shortcuts

Key
F2 Open patient HElp
F3 New record (for item selected in Index E1
patient tree)
Online
F4 Word processor L\S
F5 Refresh screen About
F6 To Do List
F7 Allergies and adverse reactions
F8 Internal messages
F9 Print current open record
F10 Edit patient details

Train IT Medical trainitmedical.com.au



Data cleansing

COIL REMOWAL

COLON

COLONO

COLONOSC

COLONOSCO

COLONOSCOP

COLONOSCOPE

COLONOQSCOPY

COLONOSCOPY AND ENDOSCOPY
COLONOSCOPY REPORT AND REVIEVY
COLONSCOPY

COLPOSCOPY

v' Reminder lists > merge

v Use reminders with ‘Clinically Significant’ labels to separate

recalls from reminders.

Train IT Medical
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Actions, Recalls and Reminders

m RECALLS (ie clinically significant/medico-legal)
eg previous melanoma, inconclusive CST

B REMINDERS eg. immunisation, skin check, routine Cervical
Screening Test (CST)

m ACTIONS eg check blood pressure

TIPS:

v' Define your reminder list

v' Label your reminders simply so patients don’t stress if they receive a
notification or letter with the reason

v' Keep your list tidy

v' Delete reminders

Train IT Medical trainitmedical.com.au



BEST PRACTICE — REMINDER MANAGEMENT PROTOCOL — SAMPLE g/

DOCTOR ADDS REMINDER to PATIENT FILE

Train IT Medical

v

If REMINDER is ‘CLINICALLY SIGNIFICANT’

]

Admin staff to generate list of
‘CLINICALLY SIGNIFICANT’ reminders DAILY

!

l

If REMINDER is NOT ‘CLINICALLY SIGNIFICANT

Admin staff: Generate a list & phone or message patients for follow
up visit/appointment due within 1 week. Use ‘Mark as Sent’ when
contacted. DO NOT Auto Update reminder when prompted.

!

Admin staff to generate a list of all reminders
not marked ‘Clinically Significant’ WEEKLY
that are due wilhin next fortnight

!

Practice nurse —Generate list & phone or message patients
on the reminder list. Tick ‘Mark as Sent’ and do not Auto
update reminder when prompted.

|

|

Admin staff: Generate a list of all ‘Clinically Significant’ reminders
that are overdue and have previously been contacted (View>Sent
Reminders). Phone or message all patients on the list who have
not yet been contacted or who don’t have an appointment.

b

Practice nurse — Generate Sent Reminders List and select
‘Mark’ to remove any that have already returned. Phone or
message patients on the list. If no response, Mail merge /
send letter to patients on Sent Reminders list. Tick ‘Mark as
Sent’ and do not ‘Auto Update Reminder’ when prompted.

Admin staff: Generate list of all ‘Clinically Significant’ reminders
that are overdue and have had 2 previous contact attempts.
Advise doctor patient has not responded, consider sending
Registered Letter.

|

Practice nurse - If patients have not returned or cannot he
contacted after 2 attempts, advise doctor.

v

|

Doctor removes/updates reminder (Open patient > Reminders button>Remove or Edit) and marks outstanding investigation /
correspondence as ‘given’ if relevant when patient returns.

Train IT Medical
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~ = 1 will remember o remove the recall. | will remember To remove the recall.
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1 will remember To remove the recall. | will remember o remove the recall. ”
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5 1 will remember to remove the recall. | will remember to remove the recall. s
X ‘ : Rick
~* 1 will remember to remove the recall. | will remember to remove the recall. 3
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I will remember o remove the recall. | will remember to remove the recall. =

:d:j

-
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! will remember to remove the recall. | will remember to remove the recall.
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My Health Record

General Practice Hospitals Specialists Pathology Allied Health Pharmacist

and X-Ray

My Health Record

[ Discharge
Shared Health Summaries [ 1 eReferrals
Summaries Specialist
plgft':rs Pathology and  Prescription and
Event diagnostic dispense records
Summaries imaging reports
NEW -
NEW! MEDSVIEW!
www.digitalhealth.gov.au www.myhealthrecord.gov.au

Train IT Medical
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http://www.digitalhealth.gov.au/
http://www.myhealthrecord.gov.au/

View My Health Record through Bp Premier
¥

-
iy wex HEE om 958l > | Finalie vis| | | My Health Record
Mobile: 0455555555 wark:
Comment:
Alcohal: Elite zports: Ethnicity:  Mon Aboriginald/ Tormes Strait |zlander
Advance Health Directive:
| | # iy Health Record Document List - Mr Caleb Derrington n
DocumentType: | Al v [ Show last 3 months only Update
Exclude Medizare documents Exclude prescription and dizpense records Exclude superseded or remaved documents Feset

|Current fiter: Excluding Medicare documents; Excluding prezcription and dispense records; Excluding superseded or removed recards

2 Document Date  Service Date Document Organisation Organisation Type

" a2mzeory Mediines Visw Local Gavernment Healhare Adrinistation

& 2241142017 Ewent Sﬁmmary Medical Center Local Government Healthcare Administration

e_ 22112007 Shared Health Summary Medical Center Local Government Healthcare Administration
03/04/2017 Shared Health Summary Medical Center General Practice

: 02/04/207 e-Referal Medical Canter General Practice

|| 0370452017 Specialist Letter edical Center General Practice

q 03/04/2017 Digcharge Surmmarny Medical Certer General Practice

M 270352017 Pathaology Report Sullivan Micolaides Pathology Pathology and Diagnostic Imaging Services

m 27032017 Diagnosztic Imaging Report Imaging Queensland Pathology and Diagnostic Imaging 5 ervices
17032017 Diagnaostic Imaaing Report Wesley Medical maging Pathology and Diagnostic Imaging Services
17032017 Pathology Report tater Pathology Pathology and Diagnostic [maging Services
10/03/2017 Pathology Report Pathology Queensland Pathology and Diagnostic Imaging Services
104032017 Diagnostic Imaging Report Brizhane Diagnostics Pathology and Diagnostic [maging Services
01/03/2017 Diagnostic Imaging Report Queenzland Diagnostic Imaging Pathology and Diagnostic Imaging Services
01/03/2017 Pathology Report QML Pathology Pathology and Diagnostic Imaging S ervices

Save a docu ment to Superseded Femoved
Correspondence I n ﬁ Open Histary Supersede Access Code Close
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To enable
faster
retrieval of
relevant
documents
change the
filters

Train IT Medical

—

4

N
My Health Record - Mr Caleb Derrington

| This is not a complete view of the individual’s health information. For more information about the individual's health record or data, please consult the individual or other healthcare professionals as needed.

View Latest Shared Health Summary

Document List

/ﬂlters

Reset Filter

From:

(V] 28Nov-2017 @~
To

(V] 28-Nov-2018 "
Document Type:

All v
Saved Status:

All v

Exclude Medicare documents

Exclude prescription and
dispense records

Exclude superseded or
removed documents

Update

N J

Current filter:

o8

/\ Document Date  Service Date

2211172017
221112017
03/04/2017
03/04/2017
03/04/2017
03/04/2017
27/03/2017
27/03/2017
17/03/2017
17/03/2017
10/03/2017
10/03/2017
01/03/2017
01/03/2017

Superseded

Open

Removed

Save

History

Document
Shared Health Summaw
Event Summary
e-Referal
Specialist Letter
Discharge Summary
Shared Health Summary
Diagnostic Imaging Report
Pathology Report
Pathology Report
Diagnostic Imaging Report
Diagnostic Imaging Report
Pathology Report
Pathology Report
Diagnostic Imaging Report

Supersede

Organisation

Medical Center

Medical Center

Medical Center

Medical Center

Medical Center

Medical Center

Imaging Queensland
Sullivan Nicolaides Pathology
Mater Pathology
Wesley Medical Imaging
Brisbane Diagnostics
Pathology Queensland
QML Pathology

Local Government Healthcare : Not Saved
Local Government Healthcare : Not Saved

General Practice Not Saved
General Practice Not Saved
General Practice Not Saved
General Practice Not Saved

Pathology and Diagnostic ImagNot Saved
Pathology and Diagnostic ImagNot Saved
Pathology and Diagnostic ImagNot Saved
Pathology and Diagnostic ImagNot Saved
Pathology and Diagnostic ImagNot Saved
Pathology and Diagnostic ImagNot Saved
Pathology and Diagnostic ImagNot Saved

Queensland Diagnostic Imagin¢ Pathology and Diagnostic Imag Not Saved

Access Code

Organisation Type Saved

; From 28-Nov-2017; To 28-Nov-2018; Excluding Medicare documents; Excluding prescription and dispense records; Excluding superseded or removed records

Close
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Patient Education

v" Custom handouts

v' HealthShare

£ Fact Sheets - O *

€2 healthshare:

Search by '@ Category Product

() Suggested () Search @ Favourites () Recent

Search
MName Crganisation Type
Asthma Action Plan Natignal Asthma Council Patients  Open | Email to patient | Remove frem favourites T
Asthma and exercise Better Health Channel Patients  Open | Email to patient | Remove frem favourites T
Asthma Management Better Health Channel Patients  Open | Email to patient | Remave from favourites ™y
Changing a wound dressing Wounds Australia Patients  Open | Email to patient | Remave from favourites ™y
Check for Signs of Skin Cancer Cancer Council Australia Patients  Open | Email to patient | Remave from favourites ™y
Colds, Coughs, Earaches and Sore Throats (Children) NPS MedicineWise Patients  Open | Email to patient | Remove from favourites ™y
Commen cold and URTI's Patient.info Patients Open | Email to patient | Remove from favourites ™y

Enable HealthShare Fact Sheets at Setup > Preferences > Enable HealthShare Fact Sheets
Remember to document patient education in Todays Notes (using Autofill?)
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Database Searches in Bp Premier

1. Select Utilities > Search (from drop down
menu)

2. Select Load Query button

3. Select a query from the list and select
Run Query

4. Print, export, mail merge or add a
reminder to the result file

Train IT Medical trainitmedical.com.au



Access SQL queries in Bp Premier

# Database search
File Help
ﬁ Open
Look in: SuppliedQueries v y T 2 - E
— | & ; . ervical screening | Observations Family/Social
H Videos s ] =
*' &=/ Pictures Type Size Run query
i, Local Disk (C:) 1 Filefolder
i ad qu
iz errEs Program Files I File folder =
- Beastpgractice Software ! File folder Save guerny
R File folder New query
Desktop -
Clinical |
# Open
Look in: | Management v| (€} T G- |
d
l Date modif.. MName A
Set the above f||e path _ 20/09/201... |:,i'°_'.|43,r|:| Patients with an appointment on a given day who haven't
t BP’ Quick access  50/09/201.. [ ATSI Patients who've been billed a 715 in the past year and hav
O access S - 20/09/201...  [£} Patients 45 - 49 with an appointment on a given day who have
Supplled QUeI’IeS 20/08/201...  [£} Patients 75+ not at a specific nursing home (specified) no 702
Desktop 20/09/201...  [£} Patients inveiced for Care Plans between specified dates.sq

Train IT Medical
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Load query > Run query

;f Database search

File Help
Y% I
Setup search: Demographics

Drugs Conditions Visits

Immunisations

Cervical screening

Observations Family/Social

SQLQuery:  [sELECT®

FROM BPFS_Patients
WHERE StatusText = ‘Active’
AND IntemallD IN (SELECT IntemallD FROM PastHistory WHERE kemCode IN (2173, 2174, 2175, 2176, 21
1727, 444, 445, 446, 447, 448, 449, 457, 453, 454, 456, 457, 458, 459, 460, 462, 469, 472, 473, 474, 476, 4
478, 480, 481, 482, 485, 486, 457, 458, 489, 490, 491, 492, 493, 494, 2269, 3208, 3214, 3217, 3218, 4828,

W

”~

[ Include inactive patients

[ Include deceased patients

9 matching records

I Run query |

Load query
Save query

Mew guery

M ame

Abbott, Madeline Jane
Adams, Felix Alexander
Ahem, Jason Patrick
Ahem, Rhonda Joan
Aldridge, Affred Charles
Alfreds, David Charles
Allen, David Charles
Allen, Janelle

Amos, Tegan

Address

12 John St, Albany Creek. 4035

35 Yarabine Road, Landsborough. 4550
17 Seymore Ave, Bentleigh. 3204

17 Seymour Ave, Bentleigh. 3204

Lazy Lakes Mursing Home, 4 King 5t. Launceston. 7.

481 Spence St, Owley. 4075

22 Star Street, Fremantle. 6160

22 Star Street, Fremantle. 6160
1/235 Rode Road, Chermside. 4032

D.0O.B.
14/02/1958
30/12/1928
31/051977
06/06/1938
24/0/1508
19/03/15930
06./10/1960
24/01/1965
11/04/1584

Age

S9yrs
89yrs
40yrs
79yrs
110yrs
7yrs
7yrs
53yrs
F3yrs

Medicare Mo.

4133180467 -
4133180466 -
3500158284 -
3500158284
5500064371 -
4133180466 -
2234567851 -
2234567831 -
3500166361 -

2
1
3
-2 30/06/2008
1
1
1
1
1

W edicare expiry

32207
31/01/2019
31/03/2007

3/07/2007
3012019
30/09/2004
30092004
311002005

File Mo,
102

987
986
781
5781
6749
6750
154

Home phone

07 50505050
07 23456987
03 45738735
03 45738735
03 36781510
07 48759654
08 59505050
08 59905050
07 58759456

whork phone

0845679412
1300959787
0739431238

I obile

0424 555333
0424 568 333
0424 583 333

08523138542
097561238
040506080621

trainitmedical.com.au
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“If you can’t measure it, you can’t improve it” reter drucker
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BEST PRACTICE SOFTWARE DATA COLLECTION
— GP Consultation Checklist

™ 3

A w
|.\r? |'\i‘
L 1 et |

Bp’

WorkrLOW & MINIMUM CLINICIAN DATA ENTRY

>
>
>
>
>
>

Review last visit/past visits

Review or collect history

Current Medications

Recent side effects/allergies

Check Result/Documents and MARK AS GIVEN

Examination & Management
(enter all observations BP, pulse etc in correct fields)

Findings/Diagnosis

Patient Education

Add/Remove Reminder or make next appointment
Enter Reason for visit

MBS item/voucher

o000 Oooppooc

v ¥V ¥V ¥V ¥
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DATABASE MANAGEMENT

Inactivate, decease or merge duplicate patient records as appropriate.
Enter Aboriginal/Torres Strait Islander status/ethnicity for all patients.
Are clinicians adding allergies, family and social history, alcohol and smoking information?

DIGITAL HEALTH

Register with one or more approved secure messaging providers

Activate ePrescribing.

Connect to My Health Record system and import Individual Health Identifiers (IHIs) for
patients when presenting for consultation

Educate practice team about My Health Record

Actively perform data cleansing including clinical coding of diagnoses.

Design and document practice policies including collecting patient consent.

Upload Shared Health Summaries

CORRESPONDENCE MANAGEMENT

Can all doctors describe the practice Correspondence Management System and are they
happy/confident with it?

Is there a clear practice protocol for scanning documents?

Are results and correspondence being marked as "Notified'?

Check Outstanding Requests lists regularly (at least monthly).

RECALL & REMINDER SYSTEM

Check Outstanding Actions list.

Check Recall protocols list.

Search for Recalls — is everything on that list current and appropriate?
Are your staff aware of the expectations/roles regarding Recalls?

Are all staff confident with the current Recall and Reminder system?

PREVENTIVE HEALTH MANAGEMENT

Ensure chronic conditions are coded.

Build chronic conditions register through proactive searches.

Follow-up patients who have not presented for review.

Organise health assessments as appropriate.

Maximise reminder systems to assist doctors to know when review is due.

trainitmedical.com.au
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Data Quality Checklist for all ‘active’ patients

Demographics ~ are the contact details up-to-date?

¢ Double-click on the patient’s telephone number to check
and update details

Medication List - is the Current Meds list accurate?
* Right click to delete/cease medications no longer relevant

[they can then be found in the Old/Past Scripts thereafter|
* |f none, tick No medications

Past History List - does it contain only significant
conditions that a hospital or specialist would need
to know?

e Right click to edit, delete or add new
¢ |f none, tick No significant past history [PMH) box

Allergies - have you also recorded adverse reactions?
* Double-click in allergies box and Add, Edit, Delete

e |f none, tick No Known Allergies/Adverse Reactions/Nil Known

@7 Immunisations - have immunisations been recorded?

Download the ‘Data Quality’ Checklist

>

trainitmedical.com.au


https://www.myhealthrecord.gov.au/sites/default/files/factsheet-data-quality-my-health-record-20170503.pdf?v=1521776350

Clinical Note-taking

« Date of consultation

 Clinician conducting the consultation

« Method of consultation eg. face to face, phone

« Reason for consultation

« Relevant clinical findings

* Follow-up of matters raised in previous consultations.

« Recommended management plan & preventive care

« Expected process of review (if necessary)

« Consent (if necessary eg. care plan, uploading health
summary, medical student, procedure).

trainitmedical.com.au



Indicators

CT.1»A Our practice has an individual patient health record for each patient, which
contains all health information held by our practice about that patient.

C7.1»B Our active patient health records contain, for each active patient, their
identification details, contact details, demographic, next of kin, and emergency contact
information.

C 7.1 C QOur patient health records include records of consultations and clinical related
communications.

C7.1»D QOur patient health records show that matters raised in previous consultations
are followed up.

C7.1»E Our practice routinely records the Aboriginal or Torres Strait Islander status of
our patients in their patient health record.

C7.1F Our practice routinely records the cultural backgrounds of our patients in their
patient health record.

C7.1»G Qur patient health records contain, for each active patient, lifestyle risk factors.

RACGP Standards

trainitmedical.com.au


https://www.racgp.org.au/download/Documents/Standards/5th%20Edition/racgp-standards-for-general-practices-5th-edition.pdf

BEST PRACTICE SOFTWARE DATA COLLECTION ® ]?" .
— GP Consultation Checklist Ol

WOoRKFLOW & MINIMUM CLINICIAN DATA ENTRY

Review last visit/past visits

Review or collect history

Current Medications

Recent side effects/allergies

Check Result/Documents and MARK AS GIVEN

Examination & Management
(enter all observations BP, pulse etc in correct fields)

YV ¥V V V ¥V ¥

Findings/Diagnosis

Patient Education

Add/Remove Reminder or make next appointment
Enter Reason for visit

MBS item/voucher

o000 o000

YV V V ¥ V¥

changes)

Upload a Shared Health Summary to My Health Record (if any

b J

2@ "
® of Jo )
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Sample Progress Note

 Standardise format and
headings

 Record observations in
correct fields

« Use Autofill for efficiency

d | Pathology requested: Urine ACR

Progress notes for PATIENT

Tuesday March 152016 11:21:02
Dr & Practitioner

Visit type:

Surgery Consultation

History:

Review diabetes

Well from this point - B3Ls mostly within tanget range 4-10 although no monitor with her today
Sleepy during the day - has not been given an appointment az vetf by the sleep clinic

Trying to be active - mows the lawn
Trying to walk the dog every day

First time ACR elevated- need to have repeated o confirm

hair loss noted owver last month
Patient says falling out in clumps and feels has bald patches

Examination:

Blood Glucese: 7.8mmoliL
BP (Sitting): 132/65

Pulse (Sitting): 60

Height: 163 cm

Weight: 108 Kg slight gain
BMI: 406

Scalp examination - no visible abnormality skin, no bald patches
Hair shafis appear normal and yishle new hair growth

Reason for contact:

Diabetes Mellitus - Type I

Management:

Chase appointment with sleep clinic

Continue same insulin for the moment

Repeat ACR to confirm elevation

Discussed hair loss - no clear patches - likely diffuze loss secondary fo severe stress few months ago (ICU admission)
- review if mot settling

Review:
212 or earlier if necessary

Actions:

Biochemistry notified by Dr & Praciiioner - VITAMIN D 16/02/2016

Biochemistry notified by Dr A Practitioner - MULTIPLE BIOCHEM ANALYSIS 16/02/2016
Biochemistry netified by Dr A Praciitioner - LIPID STUDIES 16/02/2018

Biochemistry notified by Dr A Pracfitioner - MICROALEUMIN 16/02/2016

Biochemistry notified by Dr A Pracliioner - GLYCATED HE 16/02/2016

‘| Letter Created - re. GPMP/TCA updated fo_

Action performed for Recall - PATHOLOGY TEST, due on 11/02/2016.

Medicare item:
36, 109387




Observations & results

« Enter all observations in relevant section:
Bp, BSL, spirometry, height, weight, etc
* Enter screening results — CST, FOBT, Mammogram
« Mark results as given
» Delete recalls when complete
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Edit Delete Prirt Graph
01/04/2004 0970672004 2741072004  31A12/2004 0740142005  22/09/2011 13/10/2011 27107201 13/01/2012  08/08/2016  07/08/2017 0911272017
Temp 35 Oral 35 Oral
Pulze T2 52 Regular 75 20 Regular 75 Regular
BP 14088 150100 13050 13050 13050 12080 13050 125/88
BP (Standing) 135/93 135/93
BP (Lying)
Resp
BSL 8.7 Non{asting | 7 Nonfasting | 8.7 Monfasting 9 Monfasting | 8.5 Non{asting
Height 75 175 175 175 184 185 184 175
Weight 115 58 115 109
BMI 34.0 286 34.0 356
Head Circ.
Waist 87 53 87
Hips 54 54
Waist/Hip
Chest (Inspiration)
BP

Chest (Expiration)
MMSE

K10

Diabetes rigk

02 Saturation
FEFR

CV risk

mm kg

=~

170472004

T4/08/2005 TNz

1070572008 22092008

04/02/2011

Ta06/2012

023

T5A/2015 Fae
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. . f Diabetes Cycle of Care X
Add Values Into Dlabetes Observations: | 9/12/2017 v| EBF: |125 |,-‘ |gg |‘.".|'eig|'rl: | | Height: | | Waist: | | BSL: |g.5 | [ Fasting
Record in EPC section to -
I D H I f Foot Deformity Owes e Deformity Ovwes [He
po pu ate Iabetes CyC e O examination: Ulcer Oves Mo Ulcer Oves Mo
Neuropathy ez [ne Neuropathy ez [ne
Care
Pultes [ | Present [ ]Absent Pulkes [ | Present [ ] Absent
Right: Left:
/ Diabetes Cycle of Care Fundus - -
examination:
f:gﬂnss- Date BP Weight Height BMI \
z 109kg 175cm 356 Investigations HbAIC: | | | O 9122017 ~ | ’W‘ Al same date Lookup b
Total Cholesterol: | | ||:| 9/12/2017 ~ | Triglycerides: | | | O 9122017 ~ |
| HOL Cholesterol: | | ||:| 9/12/2017 v | LDL Cholesteral: | | | O 9122017 ~ |
Foot examination: Date Deformity (R} Ulcers () Newropathy (R) Pulses (R) Creatinine: | | |I:| Py | GFR: | | | 0 922017 ~ |
24112016 Yes
Albumin/Creatining ratio: | | ||:| 9122017 v |
Micro-albuminuria: | | ||:| 122017 v | meg/min v
1
Every 12-24 Date Right Lef
months: .
Fundus examination: Lastvisitto:  Endocinclogist: [ 9/12/2017 v || |[=] Dietien: [0 9/12/2017 v || |
Ophthalmologist: ||:| 9/12/207 ~ || | Podiatrist: ||:| 9/12/2017 ~ || |
Diabetes Educator: | O 912/2017 ~ ” |
g':’:;‘;ﬂzﬂf‘g:*‘ Date HbAIC  Cholestersl  HDL Lol TrigI Save Cancel
months:
< >
Last visit to: Endocrinologist: Dietitian:
Ophthalmologist : Podiatrist:
Diabetes Educator:
Date that the last cycle of care was completed: [24/11/2016 £ Next review date: A [ Send reminder
Complete this cycle of care Add new values Close

trainitmedical.com.au




Enter screening results

-{»" Current Rx
a Past history F Investigation report >
- g Immunisations Provider: Best Paihology Sexvice w| Dateoftest: | g/12/2017 [Ev
» Investigation reports
| Test name: FOBT | [ confidential

Comespondence In

Comespondence Out Notation: Momal « | Actionto betaken: | pg action «| [[]Has been actioned
~[= Past prescriptions Checkedby: | pr Frederick Findacure | Datechecked: [ g/120017 [F~
/ Observations

Megativel

& Family/Social history

Clinical images

Enhanced Primary Care

Save Cancel

trainitmedical.com.au




Enter screening results from

d

INboX

Add C5T result

- . .
£ Cervical screening result

Date performed:

Performed by:

HPY FCR:

LBC Result:

Cther information:

Add reminder

En22017 E~ Lookup b
Dr F. Findacure v | []Include inactive providers
(®) Cervical Screening Test (") Pap smear
[] Unsatisfactany specimen
HPV 16 () Detected () Mot detected
HPV 18 () Detected () Mot detected
HPVnot 16418 (O Detected () Mot detected
Megative
] Endocervical cells present
Save Cancel
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Mark results as given

Add Wiew Delete Walues
Filter: ~ Mark result as given Atomized values
Date Test name Checked by Date checked Action Status Comment Provider
[ 28/03/2004 BIOCHEMICAL PROFILE Dr Frederick Findacure 23/02/2006 Urgent appointment Given 24/07/2017 PATHOLOGY REFORTS
] 19/05/2006 SE-SEROLOGY Dr Frederick Findacure 02/04/2017 Doctorto advise Given 24/07/2017 Abnomal PATHOLOGY REPORTS
[] 19/05/2006 SE- HIV SEROLOGY ARC Dr Frederick Findacure 25/05/2017 Reception to advise Given 24/07/2017 Abnomal Musts... PATHOLOGY REPORTS
] 1940572006 U-URIME M,C&S Dr Frederick Findacure 20/06/2017 No action fr Abnomal In hos... PATHOLOGY REFORTS
1 19+05/2006 GENERAL M,C&5 1 Dr Frederick Findacure 25/05/2017 Doctor to advise Given 24/07/2017 PATHOLOGY REFORTS
[ 31/07/2006 GENERAL MCAS51 Dr Frederick Findacure 1970672017 Doctor to advise Given 20/06/2017 MNomal As expe...  PATHOLOGY REPORTS
[ 3140772006 U-URIME M.C&S Dr Frederick Findacure 20/06/2017 Doctor to advise Given 20/06/2017 Abnormal PATHOLOGY REFORTS
[ 3140772006 SALMONELLA 1D Dr Frederick Findacure 29/06/2017 No action fr Abnormal Norma... PATHOLOGY REFORTS
[ 3140772006 HE-TROPOMIN T. Dr Frederick Findacure 24/07/2017 Doctor to advise Cortacted 20/10/2017  Abnomal PATHOLOGY REFORTS
[ 3140772006 U-URINE M,C&52 Dr Frederick Findacure 25/05/2017 No action Given 20/06/2017 MNomal PATHOLOGY REFORTS
] 17/02/2010 SE-PREGNANCY TEST Dr Frederick Findacure 20/05/2011 No action Given 20/06/2017 Normal PATHOLOGY REFORTS
1 174022010 SE-QUANTITATIVE HCG Dr Frederick Findacure 20/05/2011 No action Given 20/06/2017 MNomal PATHOLOGY REFORTS
[ 25/06/2010 Cl-COAG Dr Frederick Findacure 27/10/2011 Doctor to advise Given 20/06/2017 Acceptable PATHOLOGY REPORTS
1 1770372011 SE-_ROUTINE CHEMISTRY Dr Frederick Findacure 20/05/2011 No action Given D6/04/2017 MNomal PATHOLOGY REFORTS
] 177032011 SE-_ROUTINE CHEMISTRY Dr Frederick Findacure 20/05/2011 No action Given 06/04/2017 Normal PATHOLOGY REFORTS
[ 26/08/2011 SE-_ROUTINE CHEMISTRY Dr Frederick Findacure 27/10/2011 Doctor to advise Given D6/04/2017 Abnormal PATHOLOGY REFORTS
[ 26/08/2011 SE-LIFIDS WITH LDL Dr Frederick Findacure 27/10/2011 No action Given D6/04/2017 MNomal PATHOLOGY REFORTS
[ 267082011 U-MICROALBUMIN Dr Frederick Findacure 27/10/2011 Doctor to advise Given 06/04/2017 Abnormal PATHOLOGY REFORTS
[ 26/08/2011 ED-GLYCOSYLATED HB A1C Dr Frederick Findacure 27/10/2011 Doctor to advise Given D6/04/2017 Abnormal PATHOLOGY REFORTS
[ 26/08/2011 PAF SMEAR Dr Frederick Findacure 27/10/2011 Doctor to advise Given 06/04/2017 Abnormal PATHOLOGY REPORTS
25/05/2017 Mammoagram Dr lvar Cure 25/06/2017 No action i MNaomal Best Pathology Service
125/05/2017 fobt D Ivor Cure 25/05/2017 Mo action ir MNormal Best Pathology Service
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RECALLS

! will remember +o remove the recall.
! will remember to remove the recall.
! will remember to remove the recall.
! will remember to remove the recall.
! will remember o remove the recall.
! will remember +o remove the recall.

! will remember to remove the recall.

! will remember to remove the recall.
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! will remember to remove the recall.
! will remember to remove the recall.
! will remember to remove the recall.
! will remember to remove the recall.
! will remember to remove the recall.
! will remember to remove the recall.

! will remember o remove the recall.

! will remember o remove the recall.
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Data Quality Report Card ie
Allergies, Smoking Status etc

‘ Pen C5 CAT4 - Cleansing CAT

\

- PenCS

File Edit View Tools Data Submission  Prompts  Help

e e B % N ML

iew \,r:.-;. F’?—'-r \-’aw' _E(_.-‘- Cleansing Registrar
Collect Extracts = - Report Populztion Dashboard CAT4 CAT CAT

Medical Director 3, HCN Sample Data; Extract Date: 12/02/2015 9:57 AM; Fittering By: Conditions (Asthma - Yes)
Data Cleansing

Missing Demographics  Missing Clinical/Accreditation tems

Indicated CKD with no diagnosis  Indicated Diabetes with no diagnosis
Patient List [count = 4]

Indicated Mental Health with no diagnosis  Indicated COPD with no diagnosis

Medication Review

Show/Hide Columns Export
Double-click a patient to open it in your clinical system (MD BP Zedmed) Page No. | Go Prev Page Next Page
Firstname %ﬁ of Allergies Weight Smoking ﬁ‘:‘f‘g‘
__—
Sumame Firstname_184 12/02/1934 102.9 Smoker Sumame
Sumame Firstname_385 12/02/1541 F Recorded 1665 100 _ Ex smoker Sumame
Sumame Firstname_858 12/02/15949 M Recorded 182 28

_ Newver smoked Sumame
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Data Quality Dashboard

Demographics Ethnicity Data Quality ' Data Cleansing  Allergies  Smoking  Alcohol  Measures  Pathology  Disease  Screening
CDSA  Patient Data Report
Data Guality Dashboard  Data Completeness Report  Data Completeness Patient Graph  Duplicate Number Patient Report  Duplicate

1 of 1 @ & B A3 E- | 100% - Find | Next
Data Quality Dashboard Report Date: 01/10/2018 3:04 AM
Practice Name: Deidentified Practice
Data is taken from the Data Completeness Report and Duplicate Patients Report. View 5th Edition
Guidelines
Allergies and adverse reactions r.-"_“x 79.68% | View 4th Edition.
\ _.-I Fact Sheet
Medicines 18.16% | View 4th Edition
Fact Sheet
Medlcal Hlstory I,/f_-"‘.l 74.41% | View 4th Edition
L Eact Sheet
Health Risk Factors r..f"_“‘\ 67.35% | View 4th Edition
| ! Fact Sheet
|mmun|satlons .’/’_-l-\- 66 46% | View 4th Edition
L Fact Sheet
Relevant Famlly Hlstory 58.49% | View 4th Edition
Fact Sheet
Relevant Social History 41.43%)| View 4th Edition.
Fact Sheet
Non-Duplicate Patients . 0.00%
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For further learning and free resources:

courses.trainitmedical.com.au

trainitmedical.com.au

Subscribe to our blog

Facebook: trainitmedical
Twitter: trainitmedical
Linked In

Please leave feedback & connect with us.
With best wishes, Sue Cummins
© Train IT Medical Pty Ltd. sue@trainitmedical.com.au
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